Defense Travel System (DTS)
Voucher Instructions
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Welcome to DTS

The Defense Travel System (DTS) is a fully integrated, automated, end-
to-end travel management system that enables DoD travelers to create
authorizations (TDY travel orders), prepare reservations, receive
approvals, generate fravel vouchers, and receive a split reimbursement
between their bank accounts and the Government Travel Charge Card
(GTCC) vendor. DTS operates at over 9,500 total sites worldwide.

Login to the Defense Travel System

Begin using the Defense Travel System.
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System Status

D DTS Status

DTS is available

Updated: 25 Mar 2016

D EWTS Status

WTS is available

Updated: 19 Mar 2016
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Steps to be taken prior to logging in to DTS.

1. Locate the airfare travel invoice that was emailed from Carlson Wagonlit/SATO
prior to travel. See example below. Failure to upload the correct document
will delay your reimbursement.

Carlson
Wag?nlit | Satolravel.
rave

—_ Your Itinerary

Trip on May 13, 2015 Locator: GMAQVH Date: May 08, 2015
Traveler YOUR NARAE 1:ionT
THIS IS YOUR OFFICIAL RECEIPT FOR TRAVEL
PLEASE RETAIN FOR VOUCHERING OR
REIMBURSEMENT PURPOSES.
Customer Number
Agent 0oJ

2. Gather all other receipts reimbursement will be requested for. Scan them and
save as a PDF to the desktop.
1. TAXI (tips are not reimbursable)
BAGGAGE FEES (overweight or excess baggage will not be reimbursed)
RENTAL CAR AND GAS
LODGING (CES students will not have lodging receipt)
OTHER MISC EXPENSES
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Travel Assistance
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DoD Lodging

Military travelers going
TDY to military installations
must check DoD Lodging
availability before booking
other accomodations. Civilians
are encouraged to use DoD
Lodging when available.

Check Availability
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Welcome to DTS

The Defense Travel System (DTS) is a fully integrated, automated, end-to
-end travel management system that enables DoD travelers to create
authorizations (TDY travel orders), prepare reservations, receive
approvals, generate travel vouchers, and receive a split reimbursement
between their bank accounts and the Government Travel Charge Card
(GTCC) vendor. DTS operates at over 9,500 total sites worldwide.

Login to the Defense Travel System

Begin using the Defense Travel System.

Login to DTS

System Status

D DTS Status

DTS is available

Updated: 11 Jul 2015

D EWTS Status

EWTS is available

Updated: 15 Jul 2015

Login to DTS <

First Time Users Training

Learn how to use DTS & find
additional training resources.

Learn more about DTS and the
tools required for use.

First Time Users

MNotices

DTS Status: 8-Hour Downtime on 7/24

EWTS Status: 8-Hour Downtime on 717

MNew Pre-Audit Flag for Lodging in DTS

Flat Rate Per Diem Calculation Change

JAVA Issues with DTS Logins

Notable
Policy

= =l Changes

News

» DoD Launches New
Integrated Lodging
Program Pilot

* Chip and PIN GTCC
Cards Issued Across
DoD

+ TSA PreCheck Program
+ Travel Policy
Compliance Program

+ Instructions for
Correcting Mission
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SELECT THE
LOGIN
BUTTON



Logged In As: ERIKA L BENKE Help for this screen

X Defense Travel System

A New Era of Government Travel
Logoff

CHOOSE OFFICIAL TRAVE L, :> Official Travel ¥| Official Travel - Others ¥| Traveler Setup ¥| Reports ¥ | Administrative W

Documents Awaiting Your Approval --> cClick Here

VOUCHERS OPTION WILL Welcome ERIKA L BENKE
APPEAR BELOW THE Organization: DAS70CAC My Signed Documents
MNo O
ARROW Org ACCESS:  pcees document ame L L
Group Access: AMSC
Mo documents found.

SELECT VOUCHERS Permission: 0,2

Message Center

Army personnel needing additional assistance for Army
specific issues should contact the DFAS-Army Tier 2.5
Help Desk at dfas.bean.jft.mbx.in-army-dts-
inquiries@dfas.mil (preferred) or 877-676-6742,

On June 15, 2015, the Department of Defense will launch
a pilot of a new Integrated Lodging Program which
includes preferred commercial lodging and integrates
the ability to book government (DoD) lodging properties
in OTS. Per the Joint Travel Regulations, travelers TDY to
select pilot sites are directed to book government
lodging or preferred commercial lodging before other
lodging options. Pilot sites include: Charleston, SC/Joint
Base Charleston, Dayton, OH/Wright-Patterson Air Force
Base, Morfolk, VA/select area U.5. installations, Saratosa
Springs, NY/Maval Support Activity Saratoga Springs,
Seattle-Tacoma Airport area, WA, Tampa, FL/MacDill Air
Force Base, or Twentynine Palms, CA/Marine Air/Ground



Defense Travel System

St

View Authorizations f Orders View Local Vouchers View Group Authorizations

Vouchers

Select Create New Voucher
From Authorization/Order

Below is a list of your vouchers. Please select the appropriate function which corresponds to the Voucher with which vou wish to work

= Create Hew Youcher From Authorization/Order = NEXT 25
Existing Vouchers

Sort by Sorted by Sort by Sort by . . Remove /

Document Hame Departure Date el TA Number View/Edit | Print Trip Cancel Amend
* If there are no _ ]

e ) JHFTHUACHUCAADS2715_V02 09/27/15 ARCHIVE ACCEPTED 1R3I54 »view | print » amend

Authorizations/Orders available to
create vouchers from, this means JHGABORONEBWAD31514_V01 03/14/14 ARCHIVE ACCEPTED 142504 »view | print » amend
the travel authorization is hung up
somewhere and needs to be JHJOHANNESBURDZ 1414 VD1 02/15/14 ARCHIVE IMAGE ACCEPT 11U3LD »view | »print + amend

amended and reapproved before a
voucher can be created.



b me e mme = e e e mm e mmm s = e = e e - mmisamasm s g o

Defense Travel System Voucher from

S Y
Authorization/Order
Voucher from Authorization/Order

Select CREATE next to

Below is a list of your authorizations. Click "Create” next to the travel autherization for which you want to create a voucher. the authorization the
voucher will be created
from.

Document Name Departure Date Status TA Number Create

JHHUNTSVILLEAD32016_AD1-01 03/20/16 PO5 ACK RECEIVED 179059 » Create <




Leave: 25-Mar-18
Please Mote: A Red 5tar { * ) indicates a required field. Carrier/Flight: | Delta Air Lines Edit

* Select a Location: -OR-  * Enter a Starting Point: (DL) 2075 Remove
Conf/PHR: DCDL*F97ESD
v | |REs: LEAVENWORTH | [ks | | Search Depart: 20-Mar-16 12:30PM
MCI—Kan_s-as City
* Start Datefmm/dd/yyyy): |03/20/2016 International Apt
Arrive: 20-Mar-16 03:29PM
ATL-Atlanta Hartsfield-
Overall Ending Point Information Jackson Intl Apt
o . . Carrier/Flight: = Delta Air Lines Edit
Please Mote: A Red Star ( * ) indicates a reguired field. {DL} 1381 Remove
* Select a Location: -OR-  * Enter an Ending Point: Conf/PMR: DCDL*FSTESS
H Depart: 20-Mar-16 05:36PM
Itinera ry | |RES: LEAVENWORTH |[ks | _Search ATL-Atlanta Hartsfield-

Jackson Intl Apt

* End Date(mm/dd/yyyy): [03/25/2016 v| Arrive: 20-Mar-16 05:35PM

HEY-Huntsville
Intemnational Airport

L H H Other Trip Information - = e =
The travel itinerary is displayed for Carrer/Flight  Detia Ai Lines Eat
Please Note: A Red Star ( * ) indicates a required field. (DL) 3402 Remove
. . . L N Conf/PNR: DCDLAFI7ESS
review. U N |eSS th e TDY was “Trip Type: Trip Description (optional): Depart: 25-Mar-16 12:37PM
AA-ROUTINE TDY/TAD % | |AMSC Intermediate * HSV-HunL-;-.rill.e-
) Course MET Redstone N ;
shortened or extended, no changes It burose: _ [esenarom ww: | ma oz
. Locator: IZNUVW ATL-Atlanta Hartsfield-
will be made here. Select the Jaclon Inl Apt
Camrier/Flight: ~ Delta Air Lines Edit.
1 *Tri ion: {DL) 1364 Remove
Continue button on the bottom Tip Duration
) 12 Hours or Less () »12 - 24 Hours - With Lodging E::::NR: EEDML’F‘?—:’: -
. = =Miar- H
right hand corner of the page. ) 1224 Hows - o Lodgine | ®) Huts0ny AT Aata Fortsies-
Arrive: 25-Mar-16 05:35PM
MCI-Kansas City
Intermaticnal Apt
*Conference/Event |Nut Applicable | Rental Car: Hertz Edit
Remove
Name: Not sppicabie _ Se81ch Conterence/vent | Adrport: HSV Huntsville
Intermatienal Airport
Confirmation: GTT20663280-
Authorization Mumber: |1T9059 | Pickup: 20-Mar-16 06:00PM
Dropoff: 25-Mar-16 06:00PM
Authorization Date: [ L::::ng: TOW?I:EPLAEE STESHUN  Edit
(mm/dd/ ) Remaove
Confirmation: 84971408
Trip Number: [1 Check-In: 20-Mar-16 09:00AM
Check-Out: 25-Mar-16 06:00PM
Comments for Travel Order:
Overall Ending Point
Leave From: HUNTSVILLE, AL Edit
Return Loc:  LEAVENWORTH,KS
Arrive: 25-Mar-18

Proceed to Per Diem Locations

Proceed to the following page: Per Diem Locations (TOW/” Vl Continue




RETURN TO LIST

owverall starting Point
Booking Travel using the Defense Travel System requires that you provide =

: . N - z Leave From:  LEAVENWORTH,KS Edit
information abouwt your TDY/TAD locations for per diem purposes. You will be —— 20-Mar-15 * -
able to request bookings for transportation (e.g., air, rail) and lodging after =
these steps are complated. Location 1: HUNTSVILLE, AL
Leave From: LEAVENWORTH,KS it
Overall starting Paine: RES: LEAVENWORTH, KS TOY/TAD Loc:  HUNTSVILLE,AL . .
ow e Per Diem Locatio
Owerall Start Date: 20-Mar-14 Leave: 25-Mar-1& e r I O C I n S
Click Here to Add a Destination in Between Carrier/Flight: | Delta Air Lines i
(DL) 2075
Location 1z HUNTSVILLE, AL P p— P m—
Arrival Date: I0-Mar-16 Depart: 20-rAar-14 1213088 .. .
MCI-Kansas it
separure e 2316 sy If the itinerary is correct and no
Arrive: 20-Mar-18 03:230M

Add = -t fizld-
FTovmS Lecaon Pl changes to the travel were made
Click on a button below to select your TDY/TAD Location. Use "Ssarch Carrier/Flight: | Delta Air Lines

- i ; . 7 (DL) 1381 . . .
Lol fo e for the pr i cato. e TOYTAD LoCatn o0 || e | ocautrress during the trip, no adjustments need

E
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Depart: 20-mar-16 05236PM .
ATL-stlanta Hartsfigld-
Flease Mote: & Red Star (¥} indicates a required fisld. Jackson intl Apt to be I I I a d e 0 n t h IS page .
Arrive: 20-Mar-14 05:35PM
search by: HEV-Huntsville

~ . International Airport
Location I State/Country - Location | . B - .
CarriersFlight: ~ Delta Air Lines Edit
(DL) 5402 Aemove C t H
Zip Code | ST AT | Conf/PNR: DCOL*FSTESS ontinue
Cepart: 25-Mar-16 12237PM
HSV-Huntsville
International Airport
* oration: Use Location Tools Abowe Arrive: 25.par-16 02-42FM

ATL-atlanta Hartsfield-
% arriving On: 03/25/2016 Jacksan Intl Apt

Carrier/Flight:  Delta Air Lines Edit
¥peparting on: 03/I5/2016 EH i =
Conf/ANR: DCDL*F3TESS
o ) Depart: 15-Mar-15 04200
Guerall End Peint: RES: LEAVENWORTH, K ATL-Atlanta Hartsfield-
averall end Date: 25-Mar-16 _ Jacksan Intl Apt
Arrive: 15-Mar-15 05:358M

MCI-Kansas City
International apt

Rental Car: Hertz

Sawve This Location

Airport: HEV Huntville
International Airport
confirmation: G7T10663280-

Pickup: 20-mMar-16 06:00PM

Dropoff: 25-pMar-16 06:00PM

Lodging: TOWNEFLACE STES HUN Edit
EEmove

Confirmation: 84971405

Check-In: 20-Mar-16 0920044

Check-out: 25-Mar-16 06200FM

overall Ending Point

Leave From:  HUNTSVILLE, AL Edit

Return Loc: LEAVENWORTH,KS

ArTive: 15-Mar-16

proceed to the following page: Travel - air w |




Air Travel

This will only appear if commercial
air was used for the TDY. No
changes will be made here at this
time.

Continue

‘ﬁl Defense Travel System Itineraw:tpm
A New Era of Government Travel

Please select a flight from the trip summary on the right to edit air reservations.

Proceed to the following page:

Awounting  Additional Options — Revisw/ Sign

Owerall Starting Point

Leave From.  LEAVENWORTH,KS
Leave: 20-Mar-16

Location 42 HUNTSVILLE AL

Leawe From: LEAVENWORTH, K5
TOY/TAD Loc: HUNTSVILLE, AL
ArTive: 20-Mar-16
Leawe: I5-Mar-16
Carrier/Flight: = Delta ajr Lines
(DL} ZO7E
Canf/PHA: DCDLFITEST
Depart: I0-Mar-16 12:30PM
MWCI-Kanzas City
International Apt
Arrive: 20-Mar-16 03:25PM
ATL-Atlanta Hartsfield-
Jackszon Intl Apt
Carrier/Flight: = Delta Ajr Lines
(DL} 1331
Canf/FHR: DCDLEFITEST
Depart: 20-Mar-16 05:36PM
ATL-Atlanta Hartsfield-
Jackszon Intl Apt
Arrive: 20-Mar-16 05:35PM
HEV-Huntsville

International Airport
Carrier/Flight:  Delta Ajr Lines

(DL} 5402

Conf/PHA: DCOL*FITESS

Depart: ZE-Mar-16 12:37PM
HEV-Huntsille
Intermational Airport

Arrive: I5-Mar-16 0Z:42PM
ATL-atlanta Hartsfield-
Jackzon Intl Apt

Carrier/Flight:  Delta Ajr Lines
(DL} 1364

Conf/PHA: DCOLAFITESS

Depart: Z5-Mar-16 04:20PM
ATL-Atlanta Hartsfield-
Jackson Intl Apt

ArTive: Z5-Mar-16 05:35PM

MCI-Hanzas City
International Apt

Rental Car: Heriz

Airport: HEV Huntzville
Intermational Airport
Confirmation:  G7720663280-

Pickup: 20-Mar-16 06:00PM
Dropaff: 25-Mar-16 05:00PM
Lodging: TO'WNEPLACE 5TES HUN

Confirmation: 84971408
Check-In: 20-Mar-16 09:004M
Check-0ut: 2E-Mar-16 052 00PM
Overall Ending Point

Leawe From: HURNTSVILLE, AL

Return Loc: LEAVENWORTH, K5
ArTive: 25-Mar-16
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Remove




Defense Travel System Itinerary  Travel Accounting  Additional Options  Review/Si
ry 2 P En
A New Era of Government Travel
UERENVAEEREY”  Mileage  Per Diem Entitlements  Substantiating Records

Non-Mileage Expenses Expenses Summary
Expense Type Date Cost E/R Non—l\/llleage EXpenses
Use this screen to enter non-mileage expenses for your travel document. .
Select an expense type, or, if you cannot find the appropriate expense baggage fees 03/20/2016 525.00 Edit
type, enter a description in the box provided. You may also use the Remove
‘create an expense item from a government charge card transaction’ link Gasoline-Rental /Govt, Car 03/26/2016 58.11 Edit :
to create an expense from current charge card transactions. Select "Save Remove Ad d, Ed It or Re move
Expenses" to save the expenses to the travel document.
Reminder: CTO Fees are a reimbursable expense to the traveler when baggage fees LR 525.00 % expe nses. M a ke sure th e
the transportation costs are charged to your Individual Government : EMIVE
T | Charee Card (IBA). Taxi - Terminal 03/25/2016 50.00 Edit
ravet Charge Card (BA) = expenses reflect the
+ create an expense item from a government charge card transaction Total Expenses: 5108.11 amou nts I |Sted on yo ur
Leawve: 20-Mar-16 Return: 25-Mar-16 H
Add Expense receipts. Please note
* Expense Type: . .
| v that tips will not be
-OR- | | reimbursed.

e ) =N Continue

* Method of Reimbursement: | GOVCC-Individual V|
= view expense details / currency calculator
Save Expense
Proceed to the following page: Expense - Mileage V|




Mileage Expenses

Add, Edit or Remove
mileage.

Continue

"% Defense 'I'ravel System

e - e e g e ———

A New Era of Government Travel

Mon-Mileage  JENEETE

RETURN TO LIST

Mileage Expenses

Use this screen to enter mileage expenses for your trip. Click on the "Save
Expenses" button to save these expenses.

Leave: 20-Mar-16 Return: 25-Mar-16 Add Expense
= Expense Type: | V|
{mm/ddyvryy)
* Method of Reimbursement: | --Please Select-- W

*mites [ | x Rate = Cost §

+ Vigw This Expense T Defaults

Save Expense

Expenses Summary

Expense Type
Pvt Auto-Terminal

Pwvt Auto-Terminal

Total Expenses:

Itinerary TraveMmeunting Additional Options  Review/Sign

Per Diem Entitlements  Substantia

Date
03/20/2016

03/25/2016

543,20

Cost
521.60

521.60

E/R
Edit
Remove
Edit
Remove

Proceed to the following page: Expense - Substantiating F V| <




Receipts

Next, upload receipts in to
Substantiating Records.
Select the Browse button,
locate/select the receipts
saved to the computer, then
choose the Upload button.

The next page of the
instructions will provide a
visual of what this will look
like when the document has
uploaded.

% Defense Travel System

A New Era of Government Travel

RETURN TO LIST

[tinerary TraveMmuunting Additional Options  Review/Sign

Mon-Mileage O T TR IRl < hstantiating Record 5‘

To fax in your receipts click "Print Fax Cover Sheet®, and follow the instructicns on the cover sheet. Then five minutes after the fax transmission
is complete click "Refresh” to see receipts in the list. To upload receipts that you have scanned, click "Browse.." and after selecting the scanned

file click "Upload". Click “view" to view the receipts. To add or change notes on an existing receipt, under the "Motes" column select the field you
would like to change, edit the text, then click the "Save Notes" button.

r " Mou must have the free Adobe Acrobat Reader program installed on your computer to view receipts. Download the Adobe
”':'h mmﬁcmbm Reader program.

» Print Fax Cover Sheet

+ Upload Scanned Receipis | Browse._ . || Upload I

Currently there are no Receipts on file for this Voucher.

Date CTw Hotes View Remove

Refresh

Per Diem Entitlements /|

Proceed to the following page:




(Receipts Continued)

This is an example of
what the screen looks
like after the
document has
loaded.

The following page
will demonstrate how
to change the Notes
to help the voucher
examiner locate
specific receipts.

% Defense Travel System

Itinerary TraveMmuunting Additional Options  Review/Sign

Mon-Mileage  Mileage  Per Diem Enfitlernents SN &TaiubRulyf-M eyl ‘

A New Era of Government Travel

To fax in your receipts click "Print Fax Cover Sheet”, and follow the instructions on the cover sheet. Then five minutes after the fax transmission
is complete click "Refresh" {o see receipis in the list. To upload receipts that you have scanned, click "Browse.." and after selecting the scanned

file click "Upload". Click "view" to view the receipts. To add or change notes on an existing receipt, under the "Motes" column select the field you
would like to change, edit the text, then click the "Save Notes" button.

r “' [Mou must have the free Adobe Acrobat Reader program installed on your computer to view receipts. Download the Adobe
M':"h Gat % Acrobat Reader program.

= Print Fax Cover Sheet

» Upload Scanned Receipts Browse... | Upload |

Existing Receipts

Date CTw Motes Yiew Remove

O0&-Apr-2016 ] Added 04/06/16 at 12:01:55 | » Miew » Remove

Refresh Save Notes |

Proceed to the following page: | Per Diem Entitlements /|




(Receipts continued)

Highlight the date and time
listed in the Notes to rename
the document according to
the type of receipt that it is.
Choose Save Notes when you
are done.

Examples:

Airline Invoice
Rental Car Invoice
Baggage Fees, etc.

Continue

e e————————————————————————————————— e TR T AT e e

Defense Travel System Itinerary TraveMmuunting Additional Options ~ Review/Sign

A New Era of Government Travel

Mon-mileage TR CIGER P Substantiating Recurds‘

To fax in your receipts click "Print Fax Cover Sheet™, and follow the instructions on the cover sheet. Then five minutes after the fax transmission
is complete click "Refresh” to see receipts in the list. To upload receipts that you have scanned, click "Browse.." and after selecting the scanned

file click "Upload”. Click ™view" to view the receipts. To add or change notes on an existing receipt, under the "Notes" column select the field wou
would like to change, edit the text, then click the "Save Notes" button.

r " "ou must have the free Adobe Acrobat Reader program installed on your computer to view receipts. Download the Adobe
M':'h B”Amﬁnmbat Reader program.

= Print Fax Cover Sheet

* Upload Scanned Receipts Browse._ .. Upload

Existing Receipts

Date CTW View Remove
0f-Apr-2016 O |Airline Invoice \ | » View » Remove
0&-Apr-2016 |:| |Gas and Baggage Receipts | = Vi = Remove
Og-Apr-2016 | [] |Rental Car Receipt / | »View | »Remove

Refresh | Save Nutg;/l
e

i e O coirc|




’% Defense Travel System Itinerary Tra\rewoznunting Additional Options  Reviews Sign
A New Era of Government Travel

IS - Di i substantiating Records
Per Diem Entitlernents S €IS ER TR0y

Maon-Mileage

Per Diem Entitlements

Followdng is a list of per diem allowances for lodging and meals/incidentals for each day of ywour trip. The "edit" link allows you to change the
information {(e.g., duty conditions, meals provided, etc.) for a specific date or date range. The "reset” link changes the per diem information to
the default rates for that date and location.

C ES St U d e ntS W| I I h ave so | n th e| r ** The presence of two asterisks before the Location Name indicates one or more directed meals available for the day at the location were de-

. selected, impacting the allowable meal reimbursement amount,
lodging costs.

GSA State Tax Exemption Listing

. . M&IE .
. Date Location Edit Reset Ldg Cost Ldg Allowed Per Diem Rate | Code B L | D | Qtrs
Allowed
Continue :
589.00 £38.75
03/20/16 | HUNTSVILLE,AL » Edit » Reset 580.00 GOVCC- B ’ | 89 /51 NONE
Individual =rsona
589.00 551.00
03/21/16  HUNTSVILLE,AL » Edit » Reset 589,00 GOVCC- 89 /51 MOME
- Persanal
Individual
589.00 $51.00
03/22/16  HUNTSVILLE,AL » Edit » Reset £89.00 GOVCC- P : 89 /51 MOME
- ersonal
Individual
589.00 $51.00
03/23/16 | HUNTSVILLE, AL » Edit = Reset 58900 GOVCC- P N L 89 7 51 MONE
Individual rsona
589.00 51,00
03/24/16 | HUNTSVILLE,AL » Edit » Reset 580.00 GOVCC- Perscl-nal 89 /51 NONE
Individual
50.00 $38.75
03/25/16 HUNTSVILLE,AL » Edit » Reset $0.00 GOVCC- P . L 89 /51 NONE
Individual srsena

Reset All I

Proceed to the following page: Accounting Codes Vl Continue




i Defense Travel System - » . o
ACCO u nt| n g COd es % Ao Bra of Gmemmemlfrmm Itinerary  Travel  Expenses Additional Options  Review/Sign
A - -

Shows expenses allocated to
specific Lines of Accounting.

Select the appropriate accounting code for this trip. If there are multiple 16 AMSC MET
accounting codes that are required for this trip, please select all that apply.
Category Allowed Actual
For CES students: Start Date: 20-Mar-16 » Find Accounting Label COM. CARR.-| 5657.90 $657.90
LODGING 5445.00 544500
End Date: 25-Mar-16
Rental Car and Transport e i nele 28050 528050
Accounting Labels | ---Gelect--- Vl From DAS7OCAC MILEAGE 543.20 543.20
(GAS) should be allocated to | | OTHER 5125.42 $125.42
Shared LOA: ---5elect to Add--- W RENTAL CAR 574384 £248, 64
. ey : .
the sending unit’s LOA. Cossogion  [~etmaE V] TRANSPORT .1 sa.11
16 AMSC MET Sub
Selected Accounting Code(s) Total: 51,8087 51,808.77

Review the expenses listed. If
To remove an accounting code that does not apply to this trip, select the calculated Tri
1 H remove link corresponding to the accounting label to be removed. Please make alcu rp 1.808.77 1.808.77
the CommerCIaI Carrler and/or sure the LOA's assigned have costs allocated to it. Cost: 3t 5,

Rental Car amounts do not

. . View/Edit
match the receipts, the next foommirefabel | Oemeton | sodglode | Pem
page Of InStrUCtIOnS Wi” 16 AMSC MET DABTOCAC » view/ edit » rEmove
explain how to make these
adJustmentS Proceed to the following page: Payment Totals V|

If the amount of the
commercial carrier and rental
car are correct, go to page 26
of the instructions to continue
completing the voucher.



Adjusting Commercial
Carrier Amount

Choose the Travel option at
the top of the page.

’% Defense Travel System Itinerary @mense
A New Era of Government Travel ~

Mddiﬁonal Opftions  Rewview/Sign

RETURN TO LIST

Accounting Codes Expenses Summary
ccounting code for this trip. If there are multiple 16 AMSC MET
at are required for this trip, please select all that apply.
Category Allowed Actual
rt Date: 20-Mar-16 » Find Accounting Label COM. CARR.-| 5657.90 5657.50
LODGING 5445.00 5445, 00
End Date: Zh-Mar-16 MEIE 5780.50 5$280.50
Accounting Label: | ---Select— V| From DAS70CAC MILEAGE 543.20 $43.20
OTHER 5112.85 5112.85
Shared LOA: [ ---Select to Add-- v| e $248.64 $248.64
Cross Org LOA: | -—Select to Add--- v| TRANSPORT 58.11 58.11
16 AMSC MET Sub
1,796.20 1,796.20
Selected Accounting Code(s) Total: 5 E
To remove an accounting code that does not apply to this trip, select the .
remove link corresponding to the accounting label to be removed. Please make Calculated Trip £1,796.20 £1,796.20
sure the LOA’s assigned have costs allocated to it. Cost:
- . View/Edit
Accounting Label Organization te Code Remave
16 AMSC MET DARTOCAC = view/ edit > remove
Proceed to the following page: Payment Totals W |




uﬁ Defense Travel System IﬁrﬁrﬂM}:pm Accounting  Additional Options  Reviews Sign

A New Era of Government Travel

RETURN TO LIST

overall starting Paint

Please select a flight from the trip summary on the right to edit air reservations.

Proceed to the following page:

Leave From:
Leawe:

LEAVENWORTH, K5
20-Mar-16

Location 1: HUNTSVILLE AL

Leave From:
TOY/TAD Loc:
Arrive:

Leave:

Carrier/Flight:

Conf/PHR:
Depart:

Carrier/Flight:

ConfPHR:
Depart:

Carrier/Flight:

Conf/PHR:
Cepart:

Carrier/Flight:

Conf/PHR:
Depart:

Rental Car:
Airport:

Confirmation:
Pickup:
Dropoff:
Lodging:
Confirmation:
Check-Inz
Check-out:

LEAVENWORTH, K5
HUNTSVILLE AL
20-Mar-16

Z5-Mar-16

Delta ajr Lines

[DL) 2075
DCDLEFITESS
20-Mar-16 12:30PM
MCI-Kansas City
International Apt
20-Mar-16 03:29PM
ATL-atlanta Hartsfield-
Jackson intl apt

Delta Ajr Lines

(oL} 1331

DCOLFITEST
Z0-Mar-16 05:36PM
ATL-Atlanta Hartsfield-
Jackson intl Apt
Z0-Mar-16 05:35PM
HEv-Huntsville
Intemational airpart
Delta ajr Lines

(DL} 5402
DCDL*FITEST
I5-Mar-16 12:37PM
HEW-Huntsville
International Airport
I5-Mar-16 02:4ZPM
ATL-Atlanta Hartsfield-
Jacksan Inth Apt

Delta ajr Lines

[DL} 1364
DCOL*FITESS
25-Mar-16 04:20PM
ATL-Atlanta Hartsfield-
Jacksan Inth Apt
2E-Mar-16 05:35PM
MCI-¥ansas City
International Apt

Hertz

HSV Huntsville
International Airport
GF720563250-
Z0-Mar-16 06:00PM
2E-Mar-16 DS:0OPM
TO'WNEPLACE S5TES HUN

54371408
Z0-Mar-1& 09:00AM
I5-Mar-16 D6200PM

overall Ending Foint

Leawe From:
Return Loc:
Arrive:

HUNTSVILLE AL
LEAVENWORTH,KS
25-Mar-16

Expense - Mon-Mileage Vl

m
=

= Air Travel Expense Adjustment

w ( , Select the Edit option next to
the flight.

Edit
Remaove

H

m
=]
=i

§
5

Edit

m
=
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:

Owerall Starting Point

Select "Change Ticket Data" to edit flight reservation information.

Leawe From: LEAVENWORTH, K5 Edit
Leawve: 20-Mar-16
Flight Selected to Edit
Location 1: HUNTSVILLE,AL
$639.20 + Estimated Total Ticket Cost Leawe From: LEAVENWORTH, KS Edit
TOW/TAD Loc: HUNTSVILLE, AL
o i Arrive: 20-Mar-16
A Delta Air Lines Inc. (DL) Flight: 2075 g i
Depart: MCl-Kansas City International Apt At 12:30 PM On Sun 20-Mar-16 Carrier/Flight: | Delta Air Lines Edit
Arrive: ATL-Atlanta Hartsfield-Jackson Intl At 03:29 PM On Sun 20-Mar-16 (DL) 2075 Remave
Apt Conf/PNR: DCDLFO7ESS
Elasfs} . K-K Depart: 20-Mar-16 12:30PM
Nﬂ'ﬁm?ie"?? ion DCDL*F97ESS Duration: MCI-Kansas City
Ticket Nlumber' 0067758682920 Intemational Apt
Status: : TICKETED Arrive: 20-Mar-16 03:29PM
Seat Selection: 27C Seat ATL-Atlanta Hartsfield-
» 051-Other Supplementary Information Jackson Intl Apt
Carrier/Flight: | Delta Air Lines Edit
{DL) 1381 Remove
Ticket Date:  17-Mar-16 Conf/PNR: DCDL*FSTESS
Total Tax: 586,64 PassFacChg:  50.00 Fees:  50.00 Depart: 20-Mar-16 05:36PM
ATL-Atlanta Hartsfield-
Issue Date: 17-Mar-16 Jackson Intl Apt
Arrive: 20-Mar-16 05:35PM
) ) HSV-Huntsville
Flight Details Entered: Intemational Airport
Carrier/Flight:  Delta Air Lines Edit
Frequent Flyer: (DL} 5402 Remove
T COM. CARRAI Conf/PMNE: DCDL*F9TESD
ype: - AR Depart: 75-Mar-16 12:378M
Method of Reimbursement:  GOVCC-Individual HSV-Huntsville
Intemational Airport
CBA Label: Arrive: 25-Mar-16 02:42PM

ATL-Atlanta Hartsfield-
Jackson Intl Apt

Carrier/Flight: = Delta Air Lines Edit
Se e Ct t e Comments to the Travel Agent: {DL) 1364 T
+l —_—

CBA Account:

Conf/PMR: DCDL*F97ES9
M M Change Ticket Data Depart: 25-Mar-16 04:20PM
Change Ticket Data link St e
Jackson Intl Apt
Arrive: 25-Mar-16 05:35PM
MCI-Kansas City
Intemational Apt
Rental Car: Hertz Edit
Remaove
Ajrport: H5Y Huntsville

Intematicnal Airport
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i Lodging

e

Raental Car

Overall Starting Point
Use this screen to enter Other Ticketed Transportation infermation.

Leave From:  LEAVENWORTH,KS Edit
. Leave: 20-Mar-16
DoD mandates split disbursement for transportation, lodging and rental car
C h a nge t h e t I Cket Va I u e to refl eCt th e expenses. Click here for memorandum Location 1: HUNTSVILLE,AL
H H Leave From: LEAVENWORTH,KS Edit.
amount on your invoice. Please note - _ DD o HONTVILEAL
icket Information e 0-Mar-16
H H H Leave: 25-Mar-16
that if your airfare increased due to a oter o setect e reanes dntn Corer i ot o s fat
. . { emaove
change in departure time or the S — Contow, ocoLEESs
epart: -Mar- :
« . . * Type: | Comm Air {Indiv Bill) Vl MCl-Kansas City
original amount was not in US by B
. . * Description: [Air Fare (GovCC-)) | Arrive: B0-Mar-16 03:25PM
ATL-Atlanta Hartsfield-
dollars, you will require approval et [ | AT ttanta tor
= _ - . ° Carrier/Flight: = Delta Air Lines Edit
from the authorizing official before T oL 1381 Femove
. . Conf/PHR: DCDL*F97ESS
Cost: 639,20 Depart: 20-Mar-16 05: 36PM
submitting your voucher. (Faees o = 20 Mar 16 056N
. . Jackson Intl Apt
Unauthorized airfare amounts ma - beparture oate arive: 2016 053501
H H Intemational Airport
result in a delay processing your fsve Date &= PLr T e =
h (mmy/dalyyyy): DL} 5402 Remave
voucner. * Ticket Date '| Conf/PNR: DCOL*FITESS
(mmi/dd/yyyy): = Depart: 25-Mar-16 12:37PM
H5V-Huntsville
CBA Label: :l Internatienal Airport
h f h d I . k L. 5 Account Arrive: 25-Mar-16 02:420M
count: > CBA Accounts ATL-Atlanta Hartsfield-
Leave the rest of the data like it is. oA sccounts AL At
Carrier/Flight:  Delta Air Lines Edit
If necessary, add comments to the travel agent: (DL} 1364 Remave
Conf/PHR: DCDL*F97ESS
Depart: 25-Mar-16 04:20PM
Select the Save button. 25 Nar 16 042000
Jacksom Intl Apt
Arrive: 25-Mar-18 DEESSPM
= view expense details {‘n‘fle_rﬁntlﬁa??pt
Rental Car: Hertz Edit
Save I Remove
Airport: H5V Huntsville
Intematienal Airport
Confirmation: G7720663280-
Pickup: 20-Mar-16 05:30PM
Dropoff: 25-Mar-16 05:30PM
Lodging: TOWNEPLACE STES HUN | Edit



This page will reflect the adjustment
made to the commercial carrier
amount.

If you did not have a rental car go to
page 26 of the instructions to
continue completing the voucher.

"ﬁ Defense Travel System

A New Era of Government Travel

RETURN TQ

e

Iﬁnwrmxpems

Uze this soreen to enter Other Ticketed Transportaticn information.

Dol mandates split disbursement for trarsportation, lodging and rentsl car

expenses. Clhiok here for memorandum

Ticketed Transportation Saved

Ticket Information

Select the
this ticketed transparstion.

* Type: Camen &ir (Indiv Bill)
% Description: Ajir Fare (GOVCC-1)
* Ticket Ho 2: 004TTSE6B1FZ0
* Ticket Value: £39.20
Cezt: £39.20

(If gifferent from
ticket valus)

* Dep Date : 03/20711&
|zzue Diate = 03/17/2016
* Ticket Date : 031771016
CEA Label:
CEA Account:

5 view expence details

nk for the oocrrespending ticketad transportation item ta =dit

Create a Hew Ticksted Transportation Entry

Broceed to the fallowing page:

Accounting

Additional Optians  Rewiew' Sign

DOwerall Starting Point

Leave From:
Leave:

LEAVENWORTH,KS Edit
20-Mar-16

Logation 1: HUMTSYILLE.AL

Leawve From:
TEY/TAD Loc:
Arrive:

Leawve:
Carriar/ Flight:
Caonf /FHR:
Depars:

Arrive:

Carrizr/ Flight:
Conf/PHR:
Depart:

Arrive:

Carrier/Flight:
Conf/PHR:
Depare:

Arrive:

Carrizr/ Flight:
CanfPHR:
Depart:

Arrive:

Rental Car:
Adrpart:

Canfirmation:
Pickup:
Dropofi:
Ladging:
Canfirmation:

Checkc-In:
Cheok-Dut:

LEAVENWORTH, KS Edit
HUNTSWILLE AL

20-Mar-16

25-Mar-16

Delsa Afr Lines Edit
(DL} 2075 Bemove
DCDL*FSTESS

20-Mar-16 12:30PM

MCl-Mansas City

International Aot

20-Mar-16 03:29PM

ATL-Atlarta Hartsfiald-

Jackson Intl Apt

Dmlza Adr Lines Edit
(DL} 1381 Remove
DCDLFITEST

20-Mar-15 05:36FW
ATL-Arlanta Hartzfield-
Jdackson Intl Ape

20-Mar-15 05:35FW
HEY-Hunt=ville

Intermational Airpart

Delta Air Lines Edit
(DL} 5402 Bemeve
DCDLFITEST

25-Mar-16 12:37PM
HEY-Hunt=ville

Int=rnational Airpart

25-Mar-16 02:41PM
ATL-Arlanta Hartzfisld-
Jackzon Intl Apt

De=lza Air Lines Edit
[DL) 1364 Eemove.
DCDLFITEST

25-Mar-16 04:20PM
ATL-Atlanta Hartsfield-
Jackson Intl At
25-Mar-16 05:35PW
MCl-Banzas City
International Apt
Hertz Edit
Eemove
HEY Huntzville
Internationsl Airpart
GITI0ES3250-
20-Mar-15 05:30PW
25-Mar-15 05:30FM
TOWHNEPLACE STES HUN

[E

E49T1408
20-Mar-15 0F: 005
25-Mar-15 06:00FM

Overall Ending Peint:

Leave From:
Return Loc:
Arrive:

HUNTSVILLE &L Edit
LEAYENWORTH . KS
25-Mar-16
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Rantal Car,
-4

oOverall Starting Poink
Flease select a car rental f Leave From:  LEAVENWORTH,KS

right to edit car rental

m
=3

reservations. Leaves 20-Mar-15
Location 12 HUNTSVILLE AL
. .
Adjusting Rental Car Amount Ll s
TOY/TAD LoC: HUNTSVILLE AL
Arrive: 20-Mar-16
Leave: Z5-Mar-16
Carrier/Flight:  Delta &ir Lines Edit
(DL} 2075 Remave
Select Rental C tthet fth R Pl
elect nhental Lar a etopo e pepart: 20-Mar-16 12:30°M
MCI-Hanzas City
Intermational Apt
page . Arrive: Z0-Mar-16 03:29PM
ATL-atlanta Hartsfield-
Jackson Intl Apt
Carrier/Flight: = Delta Air Lines Edit
(oL} 1381 Remave
Conf fPHR: DCOLYFITESS
Depart: Z0-Mar-16 05:36PM
ATL-atlanta Hartsfield-
Jackson Inth Apt
Arrive: Z0-Mar-16 05:35PM
HEV-Huntsville
International Airport
Carrier/Flight:  Delta Air Lines Edit
(DL} 5402 Remove
Conf /PHR: DCOL'FITESS
Depart: 25-Mar-16 12:37PM
HSV-Huntsville
Intemational Airport
Arrive: Z5-Mar-16 02:42PM
ATL-Atlanta Hartsfield-
Jackson intl Apt
Carrier/Flight:  Delta Air Lines Edit
(oL} 1364 Remave
Conf /PHR: DCOLFITESS
Depart: Z5-Mar-16 04:20PM
ATL-Atlanta Hartsfield-
Jackson Intl Apt
Arrive: Z5-Mar-16 05:35PM
MCI-Kanzas City
International Apt
Rental Car: Hertz Edit
Eemove
Airport: H5V Huntsville
International Airport
Confirmation: GTTZ0663250-
Pickup: 20-Mar-16 06:00PM
Dropoff: ZE-Mar-16 06:00PM
Lodging: TOWNEPLACE STES HUM  Edit
Remove
Confirmation: 54971408
Check-In: 20-Mar-16 05:00AM
Check-Out: Z5-Mar-16 D5:00PM
overall Ending Point
Leave From:  HUNTSVILLE AL Edit
Return Loc: LEAVENWORTH,KS
Arrive: I5-Mar-16

Proceed to the following page: Expense - Mon-mileags V|
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Flease select a car rental from the trip summary an the right to edit car rental

reservations.

Proceed to the following page:

owerall Starting Point
Leave From:  LEAVENWORTH,KS
Leave: 20-Mar-16

Location 1: HUNTSVILLE, AL

Leave From: LEAVENWORTH, K5
TDY/TAD LbC: HUNTSVILLE, AL
ArTive: 20-Mar-16
Leave: I5-Mar-16
carrier/Flight: = Delta &ir Lines
(DL} 2075
Canf/PHA: DCOLYFITEST
Depart: 20-Mar-16 12:30PM
MCI-Kansas City
Intemational Apt
ArTive: 20-Mar-16 03:29PM
ATL-Atlanta Hartsfield-
Jacksan intl Apt
Carrier/Flight: = Delta Ajr Lines
(oL} 1381
Canf/PHA: DCOLYFITEST
Depart: 20-Mar-16 052 36PM
ATL-Atlanta Hartsfield-
Jackzan intl Apt
Arrive: 20-Mar-16 05:35PM
Hv-Huntsville

Intemational Airport
Carrier/Flight:  Delta &ir Lines

(DL} 5402

Conf/PHR: DCDL*FI7EST

Depart: Z5-Mar-16 12:37PM
HEY-Huntsville
Intemational Airport

Arrive: Z5-Mar-16 02:42PM
ATL-Atlanta Hartsfield-
Jacksan Inth Apt

Carrier/Flight:  Delta &ir Lines
(DL} 1364

Conf/PHR: DCDL*FI7EST

Depart: IE-Mar-16 042 20PM
ATL-Atlanta Hartsfield-
Jacksan Inth Apt

Arrive: 25-Mar-16 05:35PM
MCI-Kanzas City
Intemational Apt

Rental Car: Hertiz

Airport: H5V Huntsville

Intemational Airport
Confirmation: | G77Z0&63Z50-

Pickup: 20-Mar-16 06:00PM
Dropaff: 25-Mar-16 06:00PM
Lodging: TOWHEPLACE STES HUH

Confirmation: 84971408
Check-In: 20-Mar-16 03 00AM
Check-Out: Z5-Mar-16 06:00PM

owerall Ending Peint

Leave From: HUNTSWILLE AL
Return Loc: LEAVEMWORTH, K5
ArTive: 25-ar-16

Expense - Mon-Mileags Vl

i
[+

Remove

ER
5

Edit
Remove

Remie

Select the Edit button next to the
Rental Car




Adjust the cost of the rental car to
reflect what the receipt shows.

A New Era of Government Travel

RETURM TO LIST

Use this screen to save the selected rental car

TOY/TAD Location: HUNTSVILLE, AL
Fickup Dats: 20-Mar-16
Pickup Time: D600 PM
Dropoff Date: 25-Mar-16
Dropoff Time: D600 P

Rental Car Selected [] (ER) En Route

$I48.64

Rental Car: Hertz
car Class: Compact Automatic

Location: HSV Huntsville International Airpart Hertz’
mental rate is estimated and dos: not includs the

Government Adminizstrative Supplemental fee of 55 per

day.

Restrictions: ‘Weekly 512400050, Extra Hour 515.00USD, Extra Day

538.00USD, Total $148.64UsD, Unlimited Milss
» O51-Other supplementary Information

Enter the following details:

pickup Date: =
Pickup Time:
Oropoft ate: =
Dropoff Time:
cos
Method Of Reimbursement:

Comments to the Travel Agent:

i

Then choose the Save Selected Car button

Proceed to the following page:

’ﬁbefansei’rml System Itimaﬂtnm Accounting  Additional Options  Review!Sign

owverall Starting Point

Leave From:  LEAVENWORTH,KS
Leave: 20-Mar-16
Location 1: HUNTSVILLE, AL

Leawe From: LEAVENWORTH,KS
TODY/TAD Loc: HUNTSVILLE, AL

ArTive: 20-Mar-1&

Leave: 25-Mar-16

Carrier/Flight: = Delta Air Lines
(DL} 2075

Conf/PHR: DCDL'FITEST

Depart: 20-Mar-16 12:30PM

MCI-Kanzas City
International Apt

ArTiVE: 20-Mar-16 03:29PM
ATL-atlanta Hartsfield-
Jackson Intl Apt

Carrier/Flight: = Delta Afr Lines
DL} 1351

Conf/PHR: DCOLYFITESS

Depart: 20-Mar-16 05236PM
ATL-atlanta Hartsfield-
Jackson Intl Apt

Arrive: 20-Mar-16 05:35PM
He-Huntzville

International Airport
Carrier/Flight:  Delta Air Lines

[DL) 5402

Conf/PHR: DCDLMFITEST

Depart: I5-Mar-16 12:37PM
HEV-Huntsville
International Airport

Arrive: I5-Mar-16 02:4ZPM
ATL-atlanta Hartsfield-
Jackson Intl Apt

Carrier/Flight:  Delta Afr Lines
(DL} 1364

Conf /PHR: DCDLPITESS

Depart: I5-Mar-16 04:20PM
ATL-atlanta Hartsfield-
Jackson Intl Apt

Arrive: Z5-Mar-16 052 35PM
MCI-Kan=as City
International apt

Rental Car: Hertz

Ajrport: HSV Huntsvills

International Airport
Confirmation:  GF720863280-

Pickup: 20-Mar-16 04:00PM
Dropoff: 25-Mar-16 06200PM
Lodging: TOWNEPLACE STES HUN

Confirmation: 84971403
Check-In: 20-Mar-16 03200AM
Check-Out: 25-Mar-16 08200PM

overall Ending Point

Leave From: HUNTSVILLE AL
Return Loc: LEAVENWORTH, KS
Arrive: 25-par-16

Expense - Mon-Milsags Vl

Other Trans

E

Remaove

Edit
Remove

EE
H

Edit

Edit
Remave

Edit
Remove
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| meTusn 10 st |
Rental Car

To make sure the
amounts have
changed, select the

Accounting tab at the T —

top of the screen. %ﬁum;%;m Hertz

| Car Selected [] (ER) En Route

$248.64

ive Supp il fee of S5 per

day.
i .. Weekly $124.00USD,Extra Hour $19.00USD,Extra Day

RESrictions: ¢35 00USD, Total $248.64US, Unlimited miles

» OSi-Other Supplementary Information

Enter the following details:

pickup Date: 2
siiup Time:
S— CEr—
e
con:
Method Of Reimbursement: GOvVCC v

Comments to the Travel Agent:
-l

Leave From:  LEAVENWORTH,KS Edit
Leave: 20-mar-16
Location 1: HUNTSVILLE,AL
Leave From: LEAVENWORTH,KS Edit
TOY/TAD Loc:
Arrive: 20-mar-16
Leave: 25-Mar-16
Camrier/Flight:  Delta Air Lines Edit
(oL) 2075 Remove
Conf/PNR: DCOL'FITESS
Depart: 20-Mar-16 12:30PM
MCI-Kansas City
International Apt
Arrive: 20-Mar-16 03:25PM
ATL-Atlanta Hartsfield-
Jackson Intl Apt
Carrier/Flight:  Deita Air Lines Edit
(oL) 1381 Remove
Conf/PNR: DCOL'FI7ESS
Depart: 20-Mar-16 05:36PM
ATL-Atlanta Hartsfield-
Jackson Intl Apt
Arrive; 20-Mar-16 05:35PM
HSV-Huntsville
International Airport
Carrier/Flight:  Delta Air Uines Edit
(oL) 5402 Remove
Conf/PNR: OCDL'FI7ESS
Depart: 25-Mar-16 12:37PM
HSV-Huntsville
Arrive: 25-Mar-16 02:42PM
ATL-Atlanta
Jackson Intl Apt
Carrier/Flight:  Delta Air Lines Edit
(OL) 1364 BRemove
Conf/PNR: DCDL'FI7ESS
Depart: 25-Mar-16 04:20PM
ATL-Atlanta
Jackson intl Apt
Arrive: 25-Mar-16 05:35PM
MCI-Kansas City
international apt
Rental Car: Hertz Edit
Remove
Airport: HSV Huntsville
International Airport
Confirmation: G7720663280-
Pickup: 20-Mar-16 06:00PM
Dropoff: 25-Mar-16 06:00PM
Lodging: TOWNEPLACE STESHUN  Edit
Remove
Confirmation: 84971408
Check-In: 20-Mar-16 05:00am
Check-Out: 25-Mar-16 06:00PM
S il Gt Poi
Leave From:  HUNTSVILLE AL Edit
Return Loc: LEAVENWORTH, KS
Arrive: 25-Mar-16
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Accounting Codes Expenses Summary

H select the appropriate accounting code far this trip. If there are multiple AMEC
Conflrm the expenSGS are accounting codes that are required for this trip, please select all that apply. 18 MET
Category Allowed Actual
NOW COorre ct . Seart Date: opar1s > Ei . COM. CARR-I S657.50 565750
LODGING S445.00 544500
End Dats: 25-par-14 MRIE 228050 £180.50
S | h C . accounting Label: | ---select--- | From DABTOCAC MILEAGE $43.20 $43.70
elect the Continue oTHER stizes|  siass
Shared LOA: [ -—-select to Add--- v RENTAL CAR $295.00 4$195.00
b utton CrossOrglod: [ -—-Select to Add— v TRANZEORT 5811 58.11
" J— ses) 'T':t:lm MET 502 5$1,542.56 §1,542.56
Ta remawe an accounting code that doss not apply to this trip, select the .
remove link corresponding to the accounting labed to be remaoved. Please make Calculatad Trip §1,542.56 §1,542.56
sure the LOA's assigned have costs allocated to it Cost:
Accounting Label organization “mﬁi Remove
16 AMSC MET DS TOCAL » view/edit » rEmove

Proceed to the following page: Payment Totals Vl Comtinue




"ﬁ Defense Travel System [tinerary  Trawel  Expensss A‘tmnﬁnw Review! Sign
A New Era of Government Travel

Profila Payment Totals

- overall starting Point
Following is the calculated totals for the voucher - Woucher Payment Totals save From: LEAVENWORTH,KS Edit
Leawve: 20-Mar-16
Expense SUMmary Location 1: HUNTSWILLE, AL

Pay me nt TOta I S Total Expenses; 51,540.56 LEEAETE  LEME i Edit

TOY/TAD Loc:  HUNTSVILLE, AL

Hon-Reimbursable Bxpenzes:  %0.00 “Le“;;': i:‘x:g
Reimbursable Expenses: $1,842.56 Carrier/Flight:  Delta Air Lines Edit
H . . (DL} 2075 Remove
Confirm the correct amount is going to Dbursement summary il i
Gov't Advance Paid: 50,00 FCI-Kanzas City

th G OVCC International Apt
e ¢ scheduled Partial Pmts Raid: 30000 Arrive O-Mar-18 D3I

ATL-Atlanta Hartsfield-

Previous voucher Payments:  50.00 Jackson Intl Apt
Total Prior Payments: 40.00 Carrier/Fiight:  Delta &ir Lines Edit
(DL} 1381 REmove
If any additional amount needs to go to === S| e
Depart: 10-Mar-16 D5:36PM
. Collections: 50,00 A'I'I.I:.slantal Hartzfield-
SPPECa—— - 50,00 Jackson intl &pt
the GOVCC, put that amount in the T wie | somme e
Ret To Traveler: £4,842.56 Kev-Huntsville
) I b d I Balance Due US: .00 International irport
Add’| GOVCC Amt. box and select arge | waseim G
. (DL} 5402 Remove
Ca Icu Iate sum Conf/PHR: DCOL*FITESS
e 15-Mar-16 12:37PM
. persanalis} cis)  Totalls) e . Huntsville
T £323.70 $1,342.56 International Airport
Arrive: 25-Mar-16 D2:47PM
£0.00 $0.00 ATL-Atlanta Hartsfield-
M Flus Collections: £0.00 {00 = = Jai:ksl:lr! m.u ot .
0 n I n u e CarmriersFlight:  Delta Air Lines Edit
Het to Traveler: $323.70 54756 (DL} 1364 Remove
Conf/FHR: DCDLAFITEST
Add GOWCC ATM: $0.00 Depart: 15-Mar-16 D4:20PM
ATL-Atlanta Hartsfield-
Jackson intl apt
Addl GOVCC Ame: $0.00 Arrive: 15-Mar-14 D5:35PM
MCI-Kansas City
Less Prav Pmts to “ International Apt
GOWCC[BY Travelsr): Rental Car: Hertz Edit
i REMOVE
Prev Pmt Adjustments: 50,00 50.00 sirport: HEW Huntsville
2| Distribution{Net to traveler) International Airport
- N confirmation: = G7720463Z60-
$313.70 $1,518.86 $1,542.56 Pickup: 20-Mar-15 D5-305M
Dropoff: 15-Mar-16 05:30PM
Lodging: TOWHNEPLACE STES HUN  Edit
REMOVE
Confirmation: 84971408
Check-Inz 20-Mar-15 0920080
Check-Out: 25-Mar- 14 DAZ00PM
overall Ending Paink
Leave From:  HUNTSVILLE AL Edit
Retum Loc: LEAVENWORTH, K5
Arrive: 25-Mar-16

Proceed to the following page: Preview | Continus




Preview Trip

This will show all of
the individual
expenses for the
TDY. Verify that
expenses are
accurate and no
further adjustments
need to be made.

“ﬁ Defense Travel System

A New Era of Government Travel

Print Dacument

Review the details for thiz trip betow. Ta make edits, olick on the links at the l=ft to return to that s=ction. If you have no changes prooeed to
Other Authorizations.

Dol mandates split dishurzement for transpartation, lodging and rental car sxpenses. Click here for memorandum

Reference Information

Reference:

Dacument Comments

Comments to the Approving Officlal:

Ar Comments: CTO BOOKED-PLS REVIEW SEGMENT DATES AHD TIMES PLEASE NOTE SCHEDULE
CHANGES ON YOUR [TINERARY WE RECOMMEND YOU RECONFIRM YOUR FLIGHTS WITH THE AIRLINE
14 HRS PRICR TO DEPARTURE CTO ASSISTANCE REQUIRED TO UPDATE TINERARTY .

PLEASE MOTE SCHEDULE CHANGES OH YOUR ITINERARY WE
RECOMMEND YOU RECONFIRM YOUR FLEGHTS WITH THE AIRLINE 24 HRS PRIOR TO DEPARTURE CTO
ASSISTAMCE REQUIRED TO WPDATE ITINERARY.
Lodging Comments: FN FAIRFIELD INM HSV Z0MAR CANCELED-36130132

Camments from the Travel Agene:

The use of & Gavernment-Cantracted Commercial Travel Offic={CTO) to arrange offizial travel is mandatary. If the contracted CTO is nat used
0 make céfisial travel arrangements, the travelsr must provide 2 statemant in detsil as to sxactly why the CT0 iz nat availzble or ctherwise
niot being usad.

Other Trip Infarmaticn
Trip Type: AS-ROUTINE TDY /TAD
Trip Purpase: SITE VISIT
Trip Description: AMEL Intermediate Course MET Rzdstone Ars=nalPHR Locator: [ZHUWW

Cenference./Event
Hame:

et Applizable

Overall Starting Point Time Zone: C3T (07)

Itim=rary:

; Leawe Fram: LEAYEN'WORTH,KS
Edit

Leave: 10-Mar-15

Locatton 1 - HUNTSYILLE.AL Time Zone: C5T (07}

Itim=rary:

Edit L=ave From: LEAVEMWORTH, K3
TOY/TAD Location: HUNTSYILLE, AL
Arrive: I0-Mar-16
Leave 15-Mar-16
Commerial Lodging: pagerved: Yes
.!nr Trawel: Carrier Delea Air Lines Camiments to the Travel Agent:
Edit
Flight: 2075

Itinerary  Trawel Expenses  Accounting I«dchrimalﬂptinnsM

Expenses
Han-Mileag=:
Edit
Edit
Edit
Edit
Mileags:

Edit 1.  Pwvt Auto-Tarminal

E

Per Dtem Entitlements

Ladging MAIE:

Edit

Asoounting Summary

Aotual/Estimate

Accounting Code:

COM. CARR.-I:
LODGING:

MRIE:

MILEAGE:

OTHER:

RENTAL CAR:
TRANSPORT:

16 AMSC MET Sub Total:

Calculatad Trip Cost:

Ho.  Expense Type

1. baggage fees

ra

Lo

Gasoline-Rental/Govt. Car
baggage foes

Hiotel Taes

Ho. Expense Typ=

1. Pwt Auto-Terminal

Start Date

0320016

16 AMEC MET

5657.50
5445.00
5280.50
543.10
5112.88
5295.00
58.11
51,842,586

51,842,556

Edit

Date Can beimbusemert
03:20/16 525.00 GOV -Individual
0325116 5811 GOVLL-Individual
032516 5§25.00 GOWCC-Individual
03/25M16 56285 GOV -Individual
Tatal: 8120.5%
Date From To Cast :;r:-n'gir?crnmt Miles
03/20/16 511.60 Personal L
03/25/18 11.60 Perzonal 40
Tatal: 543.10
Erd Date Tetal Lodg= Total MEIE
03/25/146 $445.00 5230.50
Allowad
16 AMSC MET  Edit
Aocounting Code: SDN: 1T?053
CIC: 2620A57GEO21001
COM. CARR.-I: S657.%0
LODGING: £445.00
MAIE: £280.50
MILEAGE: 54320
OTHER: E111.85
BENTAL CAR: £195.00
TRAHGPORT: 8811
16 AMSC MET Sub Total: §1,842.56
Caleulatad Trip Cost: 51,842.56



Preview Trip

At the bottom of the
preview trip screen is a
Disbursing Summary.

Personal (S) goes directly to
the traveler’s bank account

Individual GOVCC (S) will go
directly to the traveler’s
government travel card.

Continue

DMsbursing Summary

Teotal Prior Payments:

Balance Due US:

Met Distribution
Perzanal{s):
Imdfvidus] GOVCC[E):

Taotal{%):
Docume=nt Totals

Sctual/Estimats
COM. CARR.-I:

LODGING:
MEIE:
MILEAGE:
OTHER:
EENTAL CAR:
TRAHSPORT:

Calculated Trp Cost:

50,00
50,00

5323.70
£1,515.86
21,842,568

S657.90
44500
51B0.50
>43.10
5112.83
519300
5.1

51,842,346

Baseline Trip Yiew Workshemet
CO%. CARR.-I: 255730
LODGIMG: 544500
MEIE: SIB0.50
MILEAGE: 453.10
OTHER: 511285
RENWTAL CAR: 5195.00
TRAHSPDRT: =51
Calculated Trip Costz 51,842,586

Advances and Schedulsd Partial Payments Summary

Wo &dvances requested.

Wo Schedul=d Partial Payments Request=d.

Save And Prooeed To Dther Suths |

Proosed to the fallowing page:

| Other &uthorizations

v =




Other Authorizations

Continue

pﬁ Defense Travel System Itinerary ~ Travel Expenses  Accounting  Additional Options
A New Era of Government Travel

RETURN TO LIST Previ P Other Auths. g Pre-Audi Digital Signatu

Other Authorizations

The following are the additional authorizations that were selected based on the trip details. Enter comments to your Approving Official in the
"Remarks” boxes provided.

= Add Additional Authorizations For This Trip

Other Authorizations

Other Authorization Remarks Remove

MANUALLY ENTERED EXPENSE(S). Reimbursement claimed for
manually entered expense(s): baggage fees, baggage fees, Hotel
Taxes, Authorizing Official has specifically approved
MAMUALLY ENTERED EXPENSE | reimbursement for the manually entered expenses(s).

(5}

Save and Proceed to Pre-Audits

A e RS S— s




"ﬁ Defense Travel System

A New Era of Government Travel

Itinerary  Trawal  Expansss  Accounting wmmdupmw

Help for this soreen

Below are any items that were flagged” for thiz trip. You must provide comments in the Justification to Approving Offigial text field for flagged
items. When you are finished, or if there are no flagged it=ms, click Proceed To Digital Signature.”

DD mandates split dishursemant for transpartation, lodging and rental car =xpenses. Click here for memarandum

5 ltems have been Flagpged in this Travel Document

Pre-Audit Trip

1. Reason Flagged
= HOM-CONTRACT FARE

Justification for any flagged
items must be provided,
otherwise the voucher cannot
be submitted.

2. Reason Flagged
# HOM-CONTRACT FARE

3. Reason Flagged

Choose Save and Proceed to
Digital Signature otherwise you
may be prompted to reenter
justifications.

1 NWOM-CONTRALT FARE

4. Reason Flagged
= HOM-CONTRACT FARE

3. Adwisory

TAX

# LODGING WITH MO HOTEL

Item Description

=+ A&ir Fare selected is not 2 G5A
City Pair, GEA City Pair w/'Capacity
Limits although ane was available
at time of selection:

DL - 5402

HEV-Huntsville Intarmiational Airport

25-Mar-15 - 12:37 PM
ATL-Atlanta Hartsfield-Jacksan Intl

Apt
25-Mar-16 - 02:42 PM
Item Description

*#! A&ir Fare selected is not & G5A
City Pair, GEA City Pair w/'Capacity
Limits although ane was available
at time of selection:

DL - 2075

WCl-Kanzas City International &gt
20-Mar-16 - 12:30 PM

ATL-Atlzntz Harssfield-Jacksan Intl

Apt
20-Mar-16 - 03:29 M

Item Description

=+ A&ir Fare selected is not 2 G5A
City Pair, GEA City Pair w/'Capacity
Limits although one was available
at time of selection:

DL - 1381

ATL-Atlanta Hartsfield-Jacksan Intl

Apt
20-Mar-16 - 05:35 PM
HEV-Huntsville Intarmiational Airport

20-Mar-16 - 05:35 PM

Item Description

=+ A&ir Fare selected is not 2 G5A
City Pair, GEA City Pair w/'Capacity
Limits although one was available
at time of selection:

DL - 1384

ATL-Atlzntz Harssfield-Jacksan Intl

apt
25-Mar-15 - 04:20 PM
MCl-Kanzas City International Agt
25-Mar-16 - 05:35 PM

The following are provided for advisory purposes only

Adwvisary Description  <Help:

* Justification to Approving Officlal <Help>

Rezason Codes
[C3) - Lowesr non-contract fare available to the general
public

* Justification to Approving Offimal <Helo>

Rezason Codes
€2} - Outside normial working hours.

* Justification to Approving Officlal <Help>

Beszan Codes
[C1) - Dutside normal working hours

* Justification to Approving Officlal <Help>
Rezason Codes

[C1) - Dutside normal working hours

# YOUR YOUCHER INDICATES A LODGING EXPEMSE, BUT YOU HAWE NOT ENTERED ANY HOTEL
TAXES. |F & HOTEL TAX WAS INCURRED, PLEASE ADD IT TO THE DDCUMENT AS A SEPARATE

EXPENSE.

Save And Progeed To Digital Signature

Proczed to the following page:

Drigital Signatu




Digital Signature
Voucher is complete.

Select Submit Completed
Document.

"ﬁ I.:I.'a.fa-ns& Travel System

A Mew Era of Government Travel

RETURN Td LIST

Itinerary  Trawal  Expensas  Accounting Aﬂdiﬁmﬂ.ﬂpmrM

Pre-2udit Digital Signatura

Click below ta stamp end submit this trip avthorization for routing and approval. By submdtting you are legally signing this document.

Dacument Acticn
* Submit this dooument as:
Routing List:

Additianal Remarks:

Pending Routing Actlans

Awvziting Status Change To

SIGMED

Dacument History

Status

CREATED

[SIGNED
| LEAV-CES

Submit Completed Document |

By Level
i)
Date Time Ham=
04/06/18 1 [ERIKA BENKE
» Wimw B ; t Exil

Proosed to the following page:

The estimated transportaticn related sxpenses
and actual reimbursement may be raduced if
travel iz completed uzing a different
transportation mode than authorized by your AD.

Remarks

e 2l e




After submitting the
completed document, the
status will read SIGNED.

Due to the high volume of
travelers/students on this
installation, it may take 10-
14 BUSINESS days for the
voucher to be processed.

Please contact the travel
office with questions
regarding the travel
vouchers at 913-684-1850.

Defense Travel System

B

View Authorizations / Orders Wiew Local Vouchers View Group Authorizations

Below is a list of your vouchers. Please select the appropriate function which corresponds to the Voucher with which you wish to work

There are no Authorizations/Orders available to create Vouchers from = NEXT 25
Existing Vouchers
Sort by Sorted by Sort by Sort by . N . Remove /
Document Hame Departure Date Eirinll TA Number LLEIL B B Trip Cancel R
JHHUNTESVILLEADZ2016_ V01 03/20/16 SIGHED 179059 = view [/ edit | = print




